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快速入门

创建 SQL Server 实例
最近更新时间：2025-06-05 17:08:11

本文为您介绍通过云数据库 SQL Server 控制台创建实例的操作。

已 注册腾讯云  账号，并 实名认证 。

1. 登录 SQL Server 购买页 ，依次完成选择基础配置、设置网络和数据库、确认配置信息步骤，阅读并同意服务

条款，确认无误后，单击立即购买。

步骤一：选择基础配置

在选择基础配置步骤中，您可设置实例的基础配置和规格配置项，具体设置项如下。

基础配置

操作场景

前提条件

操作步骤

计费模式：支持包年包月和按量计费。

地域：选择实例部署的地域，为了降低访问时延、提高下载速度，建议您选择最靠近您客户的地域。

可用区：选择所选地域内的可用区，支持选择随机可用区，系统随机分配。

实例架构：支持单节点、双节点、多节点。

存储类型：

选择单节点架构时，存储类型支持选择高性能云盘、SSD 云硬盘、通用型 SSD 云硬盘、增强型 SSD 云硬

盘。

说明：

国内地区，单节点实例如有 SSD 云硬盘磁盘类型的业务需要，请 提交工单  申请。

选择双节点架构时，存储类型支持选择增强型 SSD 云硬盘、通用型 SSD 云硬盘、高性能本地 SSD。

选择多节点架构时，存储类型支持选择增强型 SSD 云硬盘、通用型 SSD 云硬盘。

详细了解各存储类型的说明和适用场景，请参见 存储类型 。

数据库版本：支持 SQL Server 2008 R2，SQL Server 2012、SQL Server 2014、SQL Server 

2016、SQL Server 2017、SQL Server 2019 Enterprise 和 Standard 版本，支持 SQL Server 

2022 Enterprise，不同实例架构对应支持的数据库版本请以购买页为准。

磁盘加密：选择上海地域、存储类型为云硬盘、数据库版本为 SQL Server 2019/2022 Enterprise的实例在 

申请开白  后可以使用磁盘加密功能。其他地域和版本暂不支持磁盘加密，如需支持，请 提交工单  申请。申请使

https://cloud.tencent.com/document/product/378/17985
https://cloud.tencent.com/document/product/378/3629
https://buy.cloud.tencent.com/sqlserver
https://console.cloud.tencent.com/workorder/category
https://cloud.tencent.com/document/product/238/71654
https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category
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规格配置

步骤二：设置网络和数据库

用磁盘加密后，磁盘加密字段才会显示。

密钥来源：当开启磁盘加密时，此项显示，当前默认密钥来源为由腾讯云提供。

备节点数量：实例架构选择为多节点后，请设置备节点数量，支持设置范围为2 - 5个，选择为单节点、双节点时

无需设置备节点数量。

多可用区部署：实例架构选择为双节点、多节点时，此项显示。多节点架构时，此项仅能选择为是。

选择是，表示设置多可用区部署，需在下一步选择备可用区，支持为每一个备节点设置备可用区。温馨提

示，备节点可用区相同，不具备可用区级容灾能力，请选择不同的备可用区。

选择否，表示不进行多可用区部署。目前仅上海、北京、广州、中国香港地域支持选择多可用区域，多可用

区是在单可用区的级别上，将同一地域的多个单可用区组合成的物理区域，可保护数据库，以防数据库实例

发生故障或可用区中断。

备可用区：选择多可用区部署后，需要选择备可用区，具体以实际可选资源为准。

类型：支持独享型。

筛选：快捷筛选所需实例的 CPU 和内存，默认选中全部 CPU、全部内存。

已选实例：显示已选实例的规格信息，包括规格类型及规格。

实例规格：显示实例的规格类型、CPU、内存、支持可用区、规格参考费用。

存储空间：选择所需磁盘容量。

网络：支持私有网络，连通性检测请参见 网络环境 ，VPC 网络和子网均支持模糊搜索。

说明：

建议云服务器和云数据库是在同一账号，且同一个私有网络内（保障同一个地域，不限可用区）。

子网是私有网络的一个网络空间，为逻辑概念，同一私有网络下可以创建不同可用区的子网，同一私

有网络下不同可用区的子网默认可以内网互通，即使您选择同地域下其他可用区的子网，实际业务连

接访问为就近逻辑，也不会增加网络时延。

安全组：一种有状态的包含过滤功能的虚拟防火墙，用于设置单台或多台云数据库的网络访问控制，是腾讯云提

供的重要的网络安全隔离手段。

说明：

支持新建安全组或者选择已有安全组，支持多选和模糊搜索。

实例名：支持立即为实例命名或者创建后再命名。

系统时区：默认支持 China Standard Time（北京时间）。

若购买双节点本地盘实例，要修改系统时区需先 提交工单  申请。

若购买单节点云盘、双节点云盘或多节点云盘实例，则无需申请，可直接修改。

https://cloud.tencent.com/document/product/238/36848
https://console.cloud.tencent.com/workorder/category
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步骤三：确认配置信息

 显示步骤一、步骤二的实例配置详情，如需修改，可直接单击编辑，确认无误后完成自动续费设置，阅读勾选服务

条款，单击立即购买。

2. 购买后返回 实例列表 ，查看创建的实例，待运行状态显示为运行中，表示实例创建成功。

1. 在 实例列表 ，单击实例 ID 或操作列的管理，进入实例管理页面。

2. 在实例管理页面，选择账号管理 > 创建账号，在弹出的对话框填写相关信息，确认无误后单击确定。

1. 在 实例列表 ，单击实例 ID 或操作列的管理，进入实例管理页面。

2. 在实例管理页面，选择数据库管理 > 创建数据库，在弹出的对话框填写相关信息，确认无误后单击确定。

字符集排序规则：实例字符集为系统数据提供排序规则，即区分大小写属性和重音属性。默认支持 

Chinese_PRC_CI_AS。

若购买双节点本地盘实例，要修改字符集规则需先 提交工单  申请。

若购买单节点云盘、双节点云盘或多节点云盘实例，则无需申请，可直接修改。

所属项目：云数据库 SQL Server 支持将实例分配至不同的项目进行管理，支持模糊搜索项目名称更快选取项

目。

标签：便于分类管理实例资源。支持添加多个标签。

维护周期和维护时间：为保证云数据库 SQL Server 实例的稳定性，后台系统会不定期在维护时间内对实例进

行维护操作。建议对业务实例设置自己可接受的维护时间，一般设置在业务低峰期，将对业务的影响降到最低，

维护周期最多支持选择7个。

自动续费（计费模式为包年包月时可设置自动续费）：勾选后账户余额足够时，根据所选购买时长，设备到期后

会按月或按年自动续费。

购买时长1 - 11个月：自动续费周期为1个月，设备到期后会按月自动续费。

购买时长1 - 5年：自动续费周期为1年，设备到期后会按年自动续费，并且享受自动续费折扣。

服务条款：《 云数据库服务条款 》、《 服务等级协议 》、《 退费说明 》。

创建账号

说明：

此账号名和密码在连接 SQL Server 云数据库时使用，请妥善保管。

创建数据库

数据库名称：由字母、数字、下划线组成，字母开头，最长32个字符。

支持字符集：选择该库采用的字符集，目前已支持大多数原生字符集。

https://console.cloud.tencent.com/sqlserver#/
https://console.cloud.tencent.com/sqlserver
https://console.cloud.tencent.com/sqlserver
https://console.cloud.tencent.com/workorder/category
https://cloud.tencent.com/document/product/301/89599
https://cloud.tencent.com/document/product/301/35530
https://cloud.tencent.com/document/product/238/32871
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授权账号：可以针对已有账号对该库进行授权，如未创建账号，可参见 创建账号 。

备注说明：输入备注说明，最多256个字符。

相关 API

API 描述

创建实例 接口（CreateDBInstances）用于创建实例。

创建基础版实例
接口（CreateBasicDBInstances）用于创建 SQL server 

基础版实例。

创建高可用实例(云服务器版本) ﻿
接口（CreateCloudDBInstances）用于创建高可用实例(云

服务器版本)。

查询售卖地域 接口 (DescribeRegions) 用于查询售卖地域信息。

查询售卖可用区 接口 (DescribeZones) 用于查询当前可售卖的可用区信息。

查询售卖规格配置 接口 (DescribeProductConfig) 用于查询售卖规格配置。

查询售卖规格状态信息

接口（DescribeSpecSellStatus）用于查询售卖规格状态信

息，其中包括售卖状态，参考价格等(实际价格以询价接口为

准)。

查询申请实例价格
接口（InquiryPriceCreateDBInstances）用于查询申请实

例价格。

查询订单信息 接口（DescribeOrders）用于查询订单信息。

根据订单号查询对应的实例 ID ﻿
接口（DescribeInstanceByOrders）用于根据订单号查询

资源 ID。

https://cloud.tencent.com/document/product/238/19973
https://cloud.tencent.com/document/product/238/46808
https://cloud.tencent.com/document/product/238/91710
https://cloud.tencent.com/document/product/238/19965
https://cloud.tencent.com/document/product/238/19963
https://cloud.tencent.com/document/product/238/19966
https://cloud.tencent.com/document/product/238/101746
https://cloud.tencent.com/document/product/238/19962
https://cloud.tencent.com/document/product/238/19937
https://cloud.tencent.com/document/product/238/95801
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连接 SQL Server 实例

连接实例场景
最近更新时间：2023-02-09 16:06:35

本文介绍在 Windows 云服务器中或 Windows 本地通过 SQL Server Management Studio（SSMS）连接

到 SQL Server 实例的几种场景及连接方式，具体操作步骤详见 从 Windows 云服务器连接 SQL Server 实

例 、 从本地连接 SQL Server 实例 。

CVM 和 SQL Server 属于同一个腾讯云主账号，位于同一个地域，网络类型都是 VPC 且处于同一个 VPC 内或

网络类型都是基础网络。

举例：例如账号1下，广州 VPC1 中的子网 A 下的 CVM 和 账号1下，广州 VPC1 中的子网 B 下的 SQL 

Server。

连接方式：通过内网连接。

CVM 和 SQL Server 属于同一个腾讯云主账号，位于同一个地域，但处于不同 VPC 内。

举例：例如账号1下，广州 VPC1 中的子网 A 下的 CVM 和广州 VPC2 中的子网 B 下的 SQL Server。

连接方式：推荐通过 云联网  连接。

CVM 和 SQL Server 属于同一个腾讯云主账号，但位于不同地域。

举例：例如账号1下，广州 VPC1 中的子网 A 下的 CVM 和北京 VPC2 中的子网 B 下的 SQL Server。

连接方式：推荐通过 云联网  连接。

CVM 和 SQL Server 属于腾讯云不同主账号。

举例：例如账号1下，广州 VPC1 中的子网 A 和账号2下，北京 VPC2 中的子网 B。

连接方式：推荐通过 云联网  连接。

从 Windows 云服务器 CVM 连接云数据库 SQL Server

场景一

场景二

场景三

场景四

从 Windows 本地连接云数据库 SQL Server

双节点（原高可用版/集群版）实例连接方式

方案1：通过 VPN  或 专线  或 云联网  连接，更安全更稳定。

方案2：通过外网连接，可在控制台 开启外网地址  或 绑定 CLB 开启外网服务 。

https://cloud.tencent.com/document/product/238/11626
https://cloud.tencent.com/document/product/238/11626
https://cloud.tencent.com/document/product/238/11627
https://cloud.tencent.com/document/product/877/18768
https://cloud.tencent.com/document/product/877/18768
https://cloud.tencent.com/document/product/877/18768
https://cloud.tencent.com/document/product/554/18980
https://cloud.tencent.com/document/product/216/7557
https://cloud.tencent.com/document/product/877/18768
https://cloud.tencent.com/document/product/238/11627#kqwwdz
https://cloud.tencent.com/document/product/238/11627#CLBKQWW
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方案3：借助 具有外网 IP 的 Linux 云服务器进行端口映射 。

单节点（原基础版）实例连接方式

方案1：通过 VPN  或 专线  或 云联网  连接，更安全更稳定。

方案2：通过外网连接，可在控制台 开启外网地址 。

方案3：借助 具有外网 IP 的 Linux 云服务器进行端口映射 。

https://cloud.tencent.com/document/product/238/11627#WWIPLJSL
https://cloud.tencent.com/document/product/554/18980
https://cloud.tencent.com/document/product/216/7557
https://cloud.tencent.com/document/product/877/18768
https://cloud.tencent.com/document/product/238/11627#kqwwdz
https://cloud.tencent.com/document/product/238/11627#WWIPLJSL
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从 Windows 云服务器连接 SQL Server

实例
最近更新时间：2024-08-05 17:56:51

本文介绍在 Windows 云服务器中通过 SQL Server Management Studio（SSMS）连接到 SQL Server 

实例，并运行简单查询的操作。

1. 登录 SQL Server 控制台 ，单击目标实例的实例 ID 进入实例管理页。

2. 根据实际连接需要，在实例管理页顶部、实例详情页右侧的实例信息内或者拓扑图内，可查询到实例的内网 IP 和

端口号，具体情形如下。

操作场景

说明：

建议云服务器和云数据库是在同一账号，且同一个 VPC 内（保障同一个地域，不限可用区）。

需要配置 CVM 和云数据库 SQL Server 的安全组出入站规则，来限制允许访问云数据库 SQL 

Server 的 IP，请参见 配置安全组 。安全组需放通云数据库 SQL Server 实例内网端口，您可登录 

SQL Server 控制台  单击实例 ID 进入详情页查看端口，并记住内网地址，用于后续连接数据库。

处于相同地域，且在同一个 VPC 时，不同可用区间云服务器和云数据库可直接通过内网 IP 互通。

处于不同地域、不同 VPC 或跨账号时，也可通过 对等连接 / 云联网   互通。

操作步骤

若当前实例为双节点，则在顶部可查询主节点的内网 IP 和端口号，在拓扑图内鼠标移至对应区域可查询对应

节点的内网 IP 和端口号，在右侧实例信息内可查询主节点、备节点（若开启了备节点只读）、只读实例（若

存在只读实例）的内网 IP 和端口号。

https://console.cloud.tencent.com/sqlserver
https://cloud.tencent.com/document/product/238/43287
https://console.cloud.tencent.com/sqlserver
https://cloud.tencent.com/document/product/553/18836
https://cloud.tencent.com/document/product/877/18768
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若当前实例为单节点，则在顶部可查询主节点的内网 IP 和端口号，在拓扑图内鼠标移至主节点读写地址处可

查询主节点的内网 IP 和端口号，在右侧实例信息内可查询主节点的内网 IP 和端口号。
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3. 登录腾讯云 Windows 云服务器，请参见 快速入门 Windows 云服务器 。本文以 Windows Server 2012 

R2 标准版64位中文版为例。

4. 在 Windows 云服务器中下载并安装 SQL Server Management Studio 。SQL Server Management 

Studio 相关介绍请参见 使用 SQL Server Management Studio 。

5. Windows 云服务器上启动 SQL Server Management Studio。在 Connect to server 页面，填写相关

信息连接云数据库。单击 Connect，稍等几分钟后，SQL Server Management Studio 将连接到您的数

据库实例。

若当前实例为只读实例，则不能从拓扑图内查询只读实例的内网 IP 和端口号，可以从顶部和右侧实例信息内

查询到。

说明：

Windows 云服务器的镜像版本支持下载的 SSMS 版本不同，如下载更新版本的 SSMS 19.1，则需

要使用 Windows Server 2019及以上的云服务器镜像，请根据实际情况选择云服务器和 SSMS 的

版本。

Server type：选择 Database Engine。

Server name：数据库实例的内网 IP 和端口号，需用英文逗号隔开。例如，内网 IP 为 10.10.10.10 、端

口号为 1433 ，则在此填入 10.10.10.10,1433 。注意使用英文标点符号。

Authentication：选择 SQL Server Authentication。

https://cloud.tencent.com/document/product/213/2764
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms
https://docs.microsoft.com/en-us/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
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6. 连接到数据库后，可以查看到 SQL Server 的标准内置系统数据库（master、model、msdb 和 

tempdb）。

7. 您可以开始创建自己的数据库并对数据库运行查询。选择 File > New > Query with Current 

Connection，键入以下 SQL 查询：

Login 和 Password：在实例账号管理页创建账号时，填写的账号名和密码。
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运行查询，SQL Server Management Studio 会返回 SQL Server 版的腾讯云云数据库实例。

select @@VERSION
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从本地连接 SQL Server 实例
最近更新时间：2024-10-30 21:58:31

本文介绍在 Windows 本地通过 SQL Server Management Studio（SSMS）连接到 SQL Server 实例，

并运行简单查询的操作。

根据云上数据库实例类型的不同，连接方式也有所差异：

若从本地连接云上双节点（原高可用版/集群版） SQL Server 实例，可通过以下3种方案进行连接。

若从本地连接单节点（原基础版） SQL Server 实例，可通过以下3种方案进行连接。

下文分别介绍如下连接方案：

2. 选择地域，在实例列表单击需要开启外网的实例 ID 或操作列的管理。

3. 在实例详情页的实例信息内的外网后面，单击开通。

4. 在开通外网设置窗口阅读并勾选提示，单击确定。

5. 开通成功后，在实例详情页基本信息下查询实例的外网 IP 地址和端口号。

1. 在本地下载并安装  SQL Server Management Studio 。SQL Server Management Studio 相关介绍

请参见  使用 SQL Server Management Studio 。

连接场景

方案1：通过 VPN  或 专线  或 云联网  连接，更安全更稳定。

方案2：通过外网连接，可在控制台 开启外网地址  或 绑定 CLB 开启外网服务 。

方案3：借助 具有外网 IP 的 Linux 云服务器进行端口映射 。

方案1：通过 VPN  或 专线  或 云联网  连接，更安全更稳定。

方案2：通过外网连接，可在控制台 开启外网地址 。

方案3：借助 具有外网 IP 的 Linux 云服务器进行端口映射 。

通过控制台开启外网地址，在本地通过 SSMS 连接到 SQL Server 实例。

通过绑定 CLB 开启外网服务，在本地通过 SSMS 连接到 SQL Server 实例。

借助具有外网 IP 的 Linux 云服务器进行端口映射，在本地通过 SSMS 连接到 SQL Server 实例。

通过控制台开启外网地址在本地通过 SSMS 连接到 SQL Server 实例

步骤1：开启外网地址

1. 登录 SQL Server 控制台 。

说明：

关于开启外网详细的注意事项和步骤，可参见 开启外网地址 。

步骤2：通过外网连接 SQL Server 实例

https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver16
https://docs.microsoft.com/zh-cn/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
https://cloud.tencent.com/document/product/554/18980
https://cloud.tencent.com/document/product/216/7557
https://cloud.tencent.com/document/product/877/18768
https://cloud.tencent.com/document/product/554/18980
https://cloud.tencent.com/document/product/216/7557
https://cloud.tencent.com/document/product/877/18768
https://cloud.tencent.com/document/product/238/11627#WWIPLJSL
https://console.cloud.tencent.com/sqlserver
https://cloud.tencent.com/document/product/238/77966
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2. 本地启动 SQL Server Management Studio。在 Connect to server  页面，填写相关信息连接云数据

库。单击 Connect，稍等几分钟后，SQL Server Management Studio 将连接到您的数据库实例。

3. 连接到数据库后，可以查看到 SQL Server 的标准内置系统数据库（master、model、msdb 和 

tempdb）。

Server type：选择 Database Engine。

Server name：实例的外网 IP 地址和端口号，需用英文逗号隔开。

Authentication：选择 SQL Server Authentication。

Login 和 Password：在实例账号管理页创建账号时，填写的账号名和密码。
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4. 现在您可以开始创建自己的数据库并对数据库运行查询。选择 File > New > Query with Current 

Connection，键入以下 SQL 查询：

select @@VERSION
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运行查询，SQL Server Management Studio 会返回 SQL Server 版的腾讯云云数据库实例。

已申请使用后端服务功能。

1. 进入 负载均衡跨地域绑定2.0申请页 。

2. 根据填好资料，填写完后提交申请。

3. 提交完内测申请后， 提单至 CLB ，申请使用后端服务功能。

绑定 CLB 开启外网服务在本地通过 SSMS 连接到 SQL Server 实例

前提条件

https://cloud.tencent.com/apply/p/y72ehzwbwzk
https://console.cloud.tencent.com/workorder/category?level1_id=6&level2_id=163&source=14&data_title=%E8%B4%9F%E8%BD%BD%E5%9D%87%E8%A1%A1%20CLB&level3_id=1068&radio_title=%E9%85%8D%E9%A2%9D/%E7%99%BD%E5%90%8D%E5%8D%95&queue=96&scene_code=41669&step=2
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进入  负载均衡购买页 ，选择完配置后单击立即购买。

1. 打开跨 VPC 访问功能（启用后 CLB 支持绑定其他内网 IP）。

a. 登录 负载均衡控制台 ，选择地域，在实例管理列表，单击实例 ID，进入实例管理页面。

b. 在基本信息页的后端服务处，单击点击配置。

c. 在弹出的对话框，单击提交即可开启。

2. 配置外网监听端口。

a. 登录 负载均衡控制台 ，选择地域，在实例管理列表，单击实例 ID，进入实例管理页面。

b. 在实例管理页面，选择监听器管理页，在TCP/UDP/TCP SSL监听器下方，单击新建。

步骤1：新购负载均衡

说明：

如果在云数据库 SQL Server 同地域已经有负载均衡实例，可以不用购买。

注意：

地域需选择云数据库 SQL Server 所在的地域。

所属网络，选择和数据库相同的 VPC。

步骤2：配置负载均衡

https://buy.cloud.tencent.com/clb
https://console.cloud.tencent.com/clb/instance
https://console.cloud.tencent.com/clb/instance
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c. 在弹出的对话框，逐步完成设置，然后单击提交即可完成创建。

1. 创建好监听器后，在监听器管理页，单击创建好的监听器，然后单击右侧出现的绑定。

步骤3：绑定 SQL Server 实例
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2. 在弹出的对话框，选择目标类型为其他内网IP，输入 SQL Server 实例的 IP 地址和端口，单击确认完成绑定。

1. 登录 SQL Server 控制台 ，选择地域，在实例列表，单击实例 ID 或操作列的管理，进入实例管理页面。

2. 在实例管理页面，选择安全组页，单击配置安全组，配置安全组规则为放通全部端口，确认安全组允许外部 IP 访

问，详细配置方法请参见 配置安全组 。

注意：

登录的账号必须是标准账号（带宽上移），如无法绑定，请 提交工单  协助处理。

步骤4：配置 SQL Server 安全组

https://console.cloud.tencent.com/sqlserver
https://cloud.tencent.com/document/product/238/43287
https://console.cloud.tencent.com/workorder/category


云数据库 SQL Server

版权所有：腾讯云计算（北京）有限责任公司 第22 共48页

1. 在本地下载并安装  SQL Server Management Studio 。SQL Server Management Studio 相关介绍

请参见  使用 SQL Server Management Studio 。

2. 本地启动 SQL Server Management Studio。在 Connect to server  页面，填写相关信息连接云数据

库。单击 Connect，稍等几分钟后，SQL Server Management Studio 将连接到您的数据库实例。

步骤5：通过外网连接 SQL Server 实例

Server type：选择 Database Engine。

Server name：CLB 的 IP 地址和端口号，需用英文逗号隔开，例如 10.0.0.1,4000 。

Authentication：选择 SQL Server Authentication。

https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver16
https://docs.microsoft.com/zh-cn/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
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3. 连接到数据库后，可以查看到 SQL Server 的标准内置系统数据库（master、model、msdb 和 

tempdb）。

4. 现在您可以开始创建自己的数据库并对数据库运行查询。选择 File > New > Query with Current 

Connection，键入以下 SQL 查询：

Login 和 Password：在实例账号管理页创建账号时，填写的账号名和密码。
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运行查询，SQL Server Management Studio 会返回 SQL Server 版的腾讯云云数据库实例。

select @@VERSION

借助具有外网 IP 的 Linux 云服务器进行端口映射在本地通过 SSMS 连接到 

SQL Server 实例

说明：

云服务器和云数据库须是同一账号，且同一个 VPC 内（保障同一个地域，不限可用区）。
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1. 登录  SQL Server 控制台 ，在实例详情页查看实例内网 IP 及端口号。该内网 IP 及端口号会在配置端口映射时

使用。

2. 准备一台具有外网 IP的 Linux 云服务器，请参见 快速入门 Linux 云服务器 。

3. 在本地使用 SSH 工具（如 SecureCRT 等，本文以 SecureCRT 为例）登录 Linux 云服务器，请参见 登

录 Linux 实例 。

考虑到数据安全性，云数据库 SQL Server 尚未开放实例外网 IP，如有需求可以利用 SSH2 的端口

映射在外网连接实例，并对其进行配置和管理。

https://console.cloud.tencent.com/sqlserver
https://cloud.tencent.com/document/product/213/2936
https://cloud.tencent.com/document/product/213/5436
https://cloud.tencent.com/document/product/213/5436
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4. 在 SecureCRT 菜单栏选择 Options > Session Options，进入会话属性设置。
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5. 在会话属性设置页，选择 Connection > Port Forwarding > Add，进入配置端口映射页。
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6. 在配置端口映射页，配置对应参数。

7. 在本地下载并安装 SQL Server Management Studio 。SQL Server Management Studio 相关介绍

请参见 使用 SQL Server Management Studio 。

8. 本地启动 SQL Server Management Studio。在 Connect to server  页面，填写相关信息连接云数据

库。单击 Connect，稍等几分钟后，SQL Server Management Studio 将连接到您的数据库实例。

Server type：选择 Database Engine。

Server name：本机 IP 地址和端口号，需用英文逗号隔开，例如 10.0.0.1,4000 。端口号需与第6步中配

置的端口保持一致。

Authentication：选择 SQL Server Authentication。

https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms
https://docs.microsoft.com/zh-cn/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
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9. 连接到数据库后，可以查看到 SQL Server 的标准内置系统数据库（master、model、msdb 和 

tempdb）。

10. 现在您可以开始创建自己的数据库并对数据库运行查询。选择 File > New > Query with Current 

Connection，键入以下 SQL 查询：

Login 和 Password：在实例账号管理页创建账号时，填写的账号名和密码。
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运行查询，SQL Server Management Studio 会返回 SQL Server 版的腾讯云云数据库实例。

select @@VERSION
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管理 SQL Server 实例
最近更新时间：2025-02-27 17:33:03

登录 SQL Server 控制台 ，在实例列表，可查看实例相关信息，以及管理实例。

实例列表页面

功能 介绍

重启

在实例列表，勾选需要重启的实例，单击重启对实例进行重启操作，支持批量重启（勾选多个实

例）。  

重启期间，实例将无法正常访问，已有的连接会断掉，请您做好准备，以免造成影响。

重启期间，如果业务写入量很大，会导致重启失败。重启失败后，实例回到重启之前状态，

实例仍可访问。

请确保在业务低峰期重启，保证重启成功率，降低对业务的影响。

续费
在实例列表，勾选需要续费的实例，单击续费对所选实例进行续费，支持批量续费（勾选多个实

例），可选择按年或按月进行续费。

设置自动

续费

在实例列表，勾选需要设置自动续费的实例，单击更多操作 > 设置自动续费，支持批量设置自

动续费（勾选多个实例），单击确定后可在该实例到期后按月自动续费，需确保设备到期时账号

余额充足。

取消自动

续费

在实例列表，勾选需要取消自动续费的实例（实例名称前标记有“续”字样的），选择更多操作 

> 取消自动续费，支持批量取消自动续费（勾选多个实例），单击确定后即可取消自动续费。

编辑标签
在实例列表上方单击更多操作 > 编辑标签，也可在对应实例操作列选择更多 > 编辑标签，可对

实例进行标签管理，如没有创建过标签可单击标签管理前往新建。

配置调整
在实例列表，您可以对数据库实例进行配置调整，支持实例升级和容灾方式调整，详细介绍请参

见 调整实例规格 。

发布订阅
在实例列表，对应实例操作列选择更多 > 发布订阅，可通过发布订阅，满足业务的数据复制和

同步需求。

销毁/退

货

在实例列表，选择更多 > 销毁/退货，可以对数据库实例进行销毁/退货，详细介绍请参见 销毁

实例 。

https://console.cloud.tencent.com/sqlserver
https://cloud.tencent.com/document/product/238/43233
https://cloud.tencent.com/document/product/238/43225
https://cloud.tencent.com/document/product/238/43225
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登录 SQL Server 控制台 ，在实例列表，单击实例 ID 或在操作列的管理，可以进入实例管理页面。您可以查看实

例详情、监控、管理数据库等。

转为包年

包月

对按量计费模式的实例，支持一键转包年包月，在实例列表操作列单击更多 > 转包年包月，选

择时长，阅读规则后单击确定即可完成。

只读实例
在实例列表，实例操作列单击更多 > 只读实例，可查看对应主实例下的只读实例和配置只读实

例 RO 组，如无只读实例，可在跳转后单击新建，扩展一个或多个只读实例。

实例管理页面

功能 介绍

实例详

情

在实例详情页面，您可以查看和操作数据库的各种信息，包括设置维护信息以及在实例架构图中添

加“只读实例”。

系统监

控

在实例监控页面，您可以查看当前数据库运行的众多核心指标的监控，详细介绍请参见 监控功能  

和 告警功能 。

https://console.cloud.tencent.com/sqlserver
https://cloud.tencent.com/document/product/238/7524
https://cloud.tencent.com/document/product/238/43293
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在实例列表，单击实例 ID 或在操作列的管理，可以进入实例管理页面，然后选择实例详情页面，可以在实例详情页

面下，查看实例架构图，实例对应节点地址，存储和备份情况，管理实例信息等。

单节点实例

单节点实例的实例详情页如下图所示：

备份恢

复

在实例备份恢复页，您可查询备份恢复历史记录和新建备份恢复任务，备份上传方式支持直接上传

文件和从 COS 下载文件，恢复方式支持全量备份文件，全量备份文件 + 日志文件，全量备份文

件 + 差异备份。

发布订

阅
在发布订阅页面，您可以创建、删除一个或多个发布订阅链路服务，详细介绍请参见 发布订阅 。

安全组 在安全组页面，您可以对数据库进行安全组的配置操作，详细介绍请参见 配置安全组 。

账号管

理

在账号管理页面，您可以对管理员账号进行管理，如修改权限、重置密码等，也可以创建账号、删

除账号，详细介绍请参见 账号管理 。

数据库

管理
在数据库管理页面，您可以创建、设置权限以及删除数据库，详细介绍请参见 数据库管理 。

只读实

例

在只读实例页面，您可以创建一个或多个只读实例，以支持用户的读写分离和一主多从应用场景，

可显著提高用户数据库的读负载能力，详细介绍请参见 只读实例 。

备份管

理

在备份恢复页面，您可以进行手动创建备份、下载备份、设置定时备份、还原备份以及回档操作，

详细介绍请参见 备份管理 。

操作日

志
在操作日志页面，您可以下载慢查询日志、开启阻塞及死锁事件采集、查询阻塞及死锁事件记录。

参数配

置

在实例参数配置页，您可查看和修改部分参数，并可查询参数修改历史。详细介绍请参见 设置实

例参数 。

数据安

全
在数据安全页面，您可以开启透明数据加密，设置加密数据库。详细介绍请参见 透明数据加密 。

实例详情页面

https://cloud.tencent.com/document/product/238/43327
https://cloud.tencent.com/document/product/238/43287
https://cloud.tencent.com/document/product/238/7521
https://cloud.tencent.com/document/product/238/43284
https://cloud.tencent.com/document/product/238/43227
https://cloud.tencent.com/document/product/238/43296
https://cloud.tencent.com/document/product/238/59255
https://cloud.tencent.com/document/product/238/59255
https://cloud.tencent.com/document/product/238/93326
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功能区

域
图示 功能 介绍

顶部信

息

﻿

﻿

修改实例

名称

实例名称主要用于对 SQL Server 实例进行区分和

管理，详情参见 修改实例名称 。

﻿

﻿

跨可用区

迁移

用于将实例迁移至同一地域内的其它可用区，详情参

见 跨可用区迁移 。

﻿

﻿

转为包年

包月

将计费模式为按量计费的实例转为包年包月，详情参

见 按量转包年包月 。

﻿

﻿

续费管理
为计费模式为包年包月的实例续费，详情参见 续费说

明 。

https://cloud.tencent.com/document/product/238/70169
https://cloud.tencent.com/document/product/238/62980
https://cloud.tencent.com/document/product/238/48711
https://cloud.tencent.com/document/product/238/3116
https://cloud.tencent.com/document/product/238/3116
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﻿

﻿

标签
使用标签可对云数据库 SQL Server 资源进行分类

管理，详情参见 设置实例标签 。

﻿

﻿

转至其他

项目

将实例分配至不同的项目进行管理，详情参见 设置实

例所属项目 。

﻿

﻿

实例备注
设置或修改实例备注，便于区分和管理实例，详情参

见 设置实例备注 。

﻿

﻿

维护周期

和时间

设置实例的维护周期和维护时间，详情参见 设置实例

维护信息 。

拓扑图

（架构

图）

﻿

﻿

主节点读

写地址

鼠标指向拓扑图中的主节点读写地址，可快捷查看主

节点的内网或外网地址，外网地址未开通时，可单击

开通， 开启外网地址 。

﻿

﻿

主节点

鼠标指向拓扑图中的主节点，可快捷查看主节点的实

例名称，以及内网或外网地址，如需开通外网地址，

可单击开通， 开启外网地址 。

﻿ 主节点存

储

鼠标指向拓扑图中的主节点存储，可查询实例存储空

间的使用情况，单击扩容，可跳转至调整配置页面进

行设置。

https://cloud.tencent.com/document/product/238/70916
https://cloud.tencent.com/document/product/238/43219
https://cloud.tencent.com/document/product/238/43219
https://cloud.tencent.com/document/product/238/70170
https://cloud.tencent.com/document/product/238/43218
https://cloud.tencent.com/document/product/238/43218
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/77966
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﻿

﻿

﻿

本地备份

鼠标指向拓扑图中的本地备份，可查询本地备份的具

体情况，例如总备份、数据备份、日志备份，以及实

际占用空间/总免费空间额度等。单击管理备份可跳转

至备份空间进行管理，详情参见 查看备份空间 。

﻿

﻿

跨地域备

份

若未开启跨地域备份，可单击拓扑图中的跨地域备份

上的“+”，开启跨地域备份。

若开启了跨地域备份，则鼠标指向拓扑图中的跨地域

备份时，可查询跨地域备份的详细使用情况。

﻿

﻿

拓扑图视

图比例
可调整拓扑图的展示比例。

实例信

息（右

侧）

﻿

﻿

隐藏/展开

实例信息
可以隐藏或展开实例信息板块。

https://cloud.tencent.com/document/product/238/70168
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双节点实例

双节点实例的实例详情页如下图所示：

﻿

﻿

主节点信

息

在右侧主节点下，可以查询主节点的内网地址、外网

地址、所属网络、配置、实例状态、版本、架构信

息。

可进行的操作包括： 更改网络 ， 开启外网 ， 配置调

整 。

https://cloud.tencent.com/document/product/238/68270
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/67860
https://cloud.tencent.com/document/product/238/67860
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功能区

域
图示 功能 介绍

顶部信

息 修改实例

名称

实例名称主要用于对 SQL Server 实例进行区分和

管理，详情参见 修改实例名称 。

﻿

﻿

跨可用区

迁移

用于将实例迁移至同一地域内的其它可用区，详情参

见 跨可用区迁移 。

﻿ 转为包年

包月

将计费模式为按量计费的实例转为包年包月，详情参

见 按量转包年包月 。

https://cloud.tencent.com/document/product/238/70169
https://cloud.tencent.com/document/product/238/62980
https://cloud.tencent.com/document/product/238/48711
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﻿

﻿

﻿

续费管理
为计费模式为包年包月的实例续费，详情参见 续费说

明 。

﻿

﻿

标签
使用标签可对云数据库 SQL Server 资源进行分类

管理，详情参见 设置实例标签 。

﻿

﻿

转至其他

项目

将实例分配至不同的项目进行管理，详情参见 设置实

例所属项目 。

﻿

﻿

实例备注
设置或修改实例备注，便于区分和管理实例，详情参

见 设置实例备注 。

﻿

﻿

维护周期

和时间

设置实例的维护周期和维护时间，详情参见 设置实例

维护信息 。

拓扑图

（架构

图）

﻿

﻿

主节点读

写地址

鼠标指向拓扑图中的主节点读写地址，可快捷查看主

节点的内网或外网地址，外网地址未开通时，可单击

开通， 开启外网地址 。

﻿

﻿

备节点只

读地址

若未开启备节点只读，可单击拓扑图中备节点只读地

址上的“+”进行开通。

若开启了备节点只读，鼠标指向拓扑图中的备节点只

读地址，可快捷查询备节点只读地址。详情参见 备节

点只读 。

https://cloud.tencent.com/document/product/238/3116
https://cloud.tencent.com/document/product/238/3116
https://cloud.tencent.com/document/product/238/70916
https://cloud.tencent.com/document/product/238/43219
https://cloud.tencent.com/document/product/238/43219
https://cloud.tencent.com/document/product/238/70170
https://cloud.tencent.com/document/product/238/43218
https://cloud.tencent.com/document/product/238/43218
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/104045
https://cloud.tencent.com/document/product/238/104045
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﻿

﻿

只读组地

址

若创建了只读实例，则会显示只读组地址板块，鼠标

指向拓扑图中的只读组地址，可快捷查询只读组地址

和配置只读组。详情参见 只读实例 RO 组 。

﻿

﻿

主节点

鼠标指向拓扑图中的主节点，可快捷查看主节点的实

例名称，以及内网或外网地址，外网地址未开通时，

可单击开通， 开启外网地址 。

﻿

﻿

备节点

若未开启备节点只读，鼠标指向拓扑图中的备节点

时，不会显示快捷信息，此时备节点用作容灾作用。

若开启备节点只读，鼠标指向拓扑图中的备节点时，

会显示备节点的只读地址，此时备节点用作只读和容

灾作用。

如需手动切换主备节点，无论是否开启备节点只读，

均可单击备节点上的切换图标操作，详情参见 手动主

备切换 。

﻿

﻿

只读实例

若创建了只读实例，则会显示只读实例板块，鼠标指

向拓扑图中的只读实例，可快捷查询只读实例内网地

址和外网地址，单击查看详情，可跳转至对应只读实

例详情页进行查看，单击右下角的主实例 ID，可返回

主实例详情页面。单击拓扑图中的只读实例上

的“+”，可新建只读实例。

﻿

﻿

主节点存

储

鼠标指向拓扑图中的主节点存储，可查询实例存储空

间的使用情况，备节点存储使用情况和主节点一致，

单击扩容，可跳转至调整配置页面进行设置。

https://cloud.tencent.com/document/product/238/43232
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/97785
https://cloud.tencent.com/document/product/238/97785
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﻿

﻿

只读实例

存储

鼠标指向拓扑图中的只读实例存储，可查询只读实例

存储空间的使用情况，单击扩容，可跳转至调整配置

页面进行设置。

﻿

﻿

本地备份

鼠标指向拓扑图中的本地备份，可查询本地备份的具

体情况，例如总备份、数据备份、日志备份，以及实

际占用空间/总免费空间额度等。

﻿

﻿

跨地域备

份

若未开启跨地域备份，可单击拓扑图中的跨地域备份

上的“+”，开启跨地域备份。

若开启了跨地域备份，则鼠标指向拓扑图中的跨地域

备份时，可查询跨地域备份的详细使用情况。

﻿

﻿

拓扑图视

图比例
可调整拓扑图的展示比例。

实例信

息（右

侧）

﻿ 隐藏/展开

实例信息

可以隐藏或展开实例信息板块。
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多节点实例

﻿

﻿

﻿

主节点信

息

在右侧主节点下，可以查询主节点的内网地址、外网

地址、所属网络、配置、实例状态、版本、架构信

息。

可进行的操作包括： 手动主备切换 ， 更改网络 ， 开

启外网 ， 配置调整 。

﻿

﻿

备节点信

息

在右侧备节点下，可以开启备节点只读，开启后可以

查询备节点只读地址。可以查询备节点的所属网络、

可用区、实例状态、主备传输方式信息。

可进行的操作包括： 开启或关闭备节点只读 ， 更改

网络 。

﻿

﻿

只读实例

信息

在右侧只读实例下，可以查询只读实例的内网地址、

外网地址、所属网络、实例状态、可用区、版本、架

构、配置、权重信息。

可进行的操作包括：切换查询其他只读实例的信息，

只读组配置 ， 更改网络 ， 开启外网 ， 配置调整 。

https://cloud.tencent.com/document/product/238/97785
https://cloud.tencent.com/document/product/238/68270
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/67860
https://cloud.tencent.com/document/product/238/104045
https://cloud.tencent.com/document/product/238/68270
https://cloud.tencent.com/document/product/238/68270
https://cloud.tencent.com/document/product/238/43232
https://cloud.tencent.com/document/product/238/68270
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/67860
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多节点实例的实例详情页如下图所示：

功能区

域
图示 功能 介绍

顶部信

息

﻿

﻿

修改实例

名称

实例名称主要用于对 SQL Server 实例进行区分和

管理，详情参见 修改实例名称 。

﻿

﻿

跨可用区

迁移

用于将实例迁移至同一地域内的其它可用区，详情参

见 跨可用区迁移 。

﻿

﻿

转为包年

包月

将计费模式为按量计费的实例转为包年包月，详情参

见 按量转包年包月 。

﻿

﻿

续费管理
为计费模式为包年包月的实例续费，详情参见 续费说

明 。

https://cloud.tencent.com/document/product/238/70169
https://cloud.tencent.com/document/product/238/62980
https://cloud.tencent.com/document/product/238/48711
https://cloud.tencent.com/document/product/238/3116
https://cloud.tencent.com/document/product/238/3116
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﻿

﻿

标签
使用标签可对云数据库 SQL Server 资源进行分类

管理，详情参见 设置实例标签 。

﻿

﻿

转至其他

项目

将实例分配至不同的项目进行管理，详情参见 设置实

例所属项目 。

﻿

﻿

实例备注
设置或修改实例备注，便于区分和管理实例，详情参

见 设置实例备注 。

﻿

﻿

维护周期

和时间

设置实例的维护周期和维护时间，详情参见 设置实例

维护信息 。

拓扑图

（架构

图）

﻿

﻿

主节点读

写地址

鼠标指向拓扑图中的主节点读写地址，可快捷查看主

节点的内网或外网地址，外网地址未开通时，可单击

开通， 开启外网地址 。

﻿

﻿

备节点只

读地址

若未开启备节点只读，可单击拓扑图中备节点只读地

址上的“+”进行开通。

若开启了备节点只读，鼠标指向拓扑图中的备节点只

读地址，可快捷查询备节点只读地址。详情参见 备节

点只读 。

﻿

﻿

主节点

鼠标指向拓扑图中的主节点，可快捷查看主节点的实

例名称，以及内网或外网地址，外网地址未开通时，

可单击开通， 开启外网地址 。

https://cloud.tencent.com/document/product/238/70916
https://cloud.tencent.com/document/product/238/43219
https://cloud.tencent.com/document/product/238/43219
https://cloud.tencent.com/document/product/238/70170
https://cloud.tencent.com/document/product/238/43218
https://cloud.tencent.com/document/product/238/43218
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/104045
https://cloud.tencent.com/document/product/238/104045
https://cloud.tencent.com/document/product/238/77966
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﻿

﻿

备节点

若未开启备节点只读，鼠标指向拓扑图中的备节点

时，不会显示快捷信息，此时备节点用作容灾作用。

若开启备节点只读，鼠标指向拓扑图中的备节点时，

会显示备节点的只读地址，此时备节点用作只读和容

灾作用。

单击拓扑图中的“+”，可添加备节点。

如需手动切换主备节点，请参见 手动主备切换 。

﻿

﻿

主节点存

储

鼠标指向拓扑图中的主节点存储，可查询实例存储空

间的使用情况，备节点存储使用情况和主节点一致，

单击扩容，可跳转至调整配置页面进行设置。

﻿

﻿

备节点存

储
备节点存储使用状况同主节点存储一致。

﻿

﻿

本地备份

鼠标指向拓扑图中的本地备份，可查询本地备份的具

体情况，例如总备份、数据备份、日志备份，以及实

际占用空间/总免费空间额度等。

https://cloud.tencent.com/document/product/238/97785
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﻿

﻿

跨地域备

份

若未开启跨地域备份，可单击拓扑图中的跨地域备份

上的“+”，开启跨地域备份。

若开启了跨地域备份，则鼠标指向拓扑图中的跨地域

备份时，可查询跨地域备份的详细使用情况。

﻿

﻿

拓扑图视

图比例
可调整拓扑图的展示比例。

实例信

息（右

侧）

﻿

﻿

隐藏/展开

实例信息
可以隐藏或展开实例信息板块。

﻿

﻿

主节点信

息

在右侧主节点下，可以查询主节点的内网地址、外网

地址、所属网络、配置、实例状态、版本、架构信

息。

可进行的操作包括： 手动主备切换 ， 更改网络 ， 开

启外网 ， 配置调整 。

https://cloud.tencent.com/document/product/238/97785
https://cloud.tencent.com/document/product/238/68270
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/77966
https://cloud.tencent.com/document/product/238/67860
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﻿

﻿

备节点信

息

在右侧备节点下，可以开启备节点只读，开启后可以

查询备节点只读地址、所属网络、可用区、实例状

态、主备传输方式信息。

可进行的操作包括： 开启或关闭备节点只读 ， 更改

网络 。

相关 API

API 描述

查询实例列表 接口（DescribeDBInstances）用于查询实例列表。

查询实例附属属性
接口（DescribeDBInstancesAttribute）用于查询实例附

属属性。

查询备机的容灾地域和可用区
接口（DescribeCrossRegionZone）根据主实例查询备机

的容灾地域和可用区。

查询实例支持的字符集和时区
接口（DescribeCollationTimeZone）用于查询实例支持的

字符集和时区。

查询流程状态 接口（DescribeFlowStatus）用于查询流程状态。

查询异步任务列表
接口（DescribeInstanceTasks）用于查询实例相关的异步

任务列表。

修改实例名字 接口（ModifyDBInstanceName）用于修改实例名字。

修改实例备注信息 接口（ModifyDBInstanceNote）用于修改实例备注信息。

修改数据库实例所属项目
接口（ModifyDBInstanceProject）用于修改数据库实例所

属项目。

实例变配检查
接口（DescribeUpgradeInstanceCheck）用于在实例变

配前，预检查实例变配的影响情况等。

升级实例 接口（UpgradeDBInstance）用于升级实例。

立刻完成扩容任务

接口（CompleteExpansion）在实例发起扩容后，实例状态

处于“升级待切换”时，可立即完成实例升级切换操作，无需等

待可维护时间窗。

https://cloud.tencent.com/document/product/238/104045
https://cloud.tencent.com/document/product/238/68270
https://cloud.tencent.com/document/product/238/68270
https://cloud.tencent.com/document/product/238/19969
https://cloud.tencent.com/document/product/238/90299
https://cloud.tencent.com/document/product/238/47201
https://cloud.tencent.com/document/product/238/101735
https://cloud.tencent.com/document/product/238/19967
https://cloud.tencent.com/document/product/238/101734
https://cloud.tencent.com/document/product/238/19958
https://cloud.tencent.com/document/product/238/101732
https://cloud.tencent.com/document/product/238/19957
https://cloud.tencent.com/document/product/238/101733
https://cloud.tencent.com/document/product/238/19948
https://cloud.tencent.com/document/product/238/46286
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实例手动主备切换 接口（SwitchCloudInstanceHA）用于手动主备切换。

重启实例 接口（RestartDBInstance）用于重启数据库实例。

主动隔离实例
接口（TerminateDBInstance）用于主动隔离实例，使得实

例进入回收站。

恢复后付费实例

接口（RenewPostpaidDBInstance）用于将通过接口 

TerminateDBInstance 手动隔离的按量计费实例从回收站中

恢复。

立即下线实例
接口（DeleteDBInstance）用于释放回收站中的 SQL 

server 实例（立即下线）。

修改实例网络
接口（ModifyDBInstanceNetwork）用于修改运行中实例

的网络，仅支持从 VPC 网络到 VPC 网络的转换。

开通实例外网 接口（ModifyOpenWanIp）用于开通实例外网。

关闭实例外网 接口（ModifyCloseWanIp）用于关闭实例外网。

https://cloud.tencent.com/document/product/238/97922
https://cloud.tencent.com/document/product/238/19951
https://cloud.tencent.com/document/product/238/38210
https://cloud.tencent.com/document/product/238/46805
https://cloud.tencent.com/document/product/238/46806
https://cloud.tencent.com/document/product/238/52347
https://cloud.tencent.com/document/product/238/101717
https://cloud.tencent.com/document/product/238/101718

